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Transforming multiple stock photos into unique digital 

works of art is my passion. My goal is to share techniques 

I use consistently to achieve dynamic results. I've 

designed the ebook for the artist that already

creates photo composites and has an understanding

of Photoshop.

The ebook is an overview of my design process with a 

focus on areas I believe are most important.

I cover key concepts and techniques, from initial planning 

to finishing effects. I walk through Pen Tool selections and 

outline techniques for building up lighting and effects for 

individual elements.

Read on, and begin incorporating these techniques into 

your own works of art.

Welcome
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What inspires or influences you? How I choose a theme 

for my work varies greatly. It often comes down to my 

mood and circumstances at the time. I tend to use a lot of 

female subjects in my work. I’ve always been fascinated by 

the power of a woman, and they make more interesting 

subjects to me.

For Mother Earth, my process went something like this: 

I wanted to use a female character. I find the thought 

of aliens interesting. Scenes of war in the news have 

been bombarding me almost daily. This thought process 

reveals how my concept was born. Mother Earth depicts 

a saddened, motherly character. She is disappointed in 

what has become of the planet she nurtured.

Inspiration and
discovering your theme

Women + Aliens + War = Mother Earth
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After establishing a concept, I create a rough sketch with 

notes. This is usually a quick thumbnail sketch in pencil or 

pen so I don’t forget my overall idea. I include notes 

about color, design elements, or any other idea I may 

want to experiment with.

With sketch in hand, I begin the search for a stock photo 

that will represent the female subject. I also locate a 

globe that will rest in her hand.

Planning your composition with
stock photos in mind
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Once the subject or central stock photos are chosen,

I sketch out the composition within Photoshop. 

Creating an initial Photoshop sketch provides a guide 

when you are selecting your remaining stock photos. 

Although the final composition does not always resemble 

the sketch, it is a good starting point. I generally don’t like 

to plan out all the details. Part of the enjoyment comes 

from discovering the work as you create it. I prefer to 

remain flexible and leave enough open to experiment.

dollarphotoclub.com/42076644

NASA
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Unless you photograph your own images, you are at the 

mercy of stock photos. I occasionally shoot my own 

photos, but I generally use stock photos. Most of my 

composite work includes so many images, it would be 

too time consuming to personally photograph 

everything. I have become accustomed to searching 

through stock photos, looking for those images that fit 

just right. Finding the right image is part of the process 

and can take some time, but it's worth it when you find 

an image that sparks your imagination.

I recently discovered the Dollar Photo Club, a stock site 

that sells images for $1 per image. With the exception of 

the NASA globe and my smoke photo, all other stock 

images were licensed from the Dollar Photo Club.
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After an initial search, I established the composition with 

these images in mind: 

 Female: dollarphotoclub.com/42076644

 NASA Globe: http://visibleearth.nasa.gov

The following supporting elements were found 

throughout the process:

 Nebula 1: dollarphotoclub.com/35031901

 Nebula 2: dollarphotoclub.com/61830159

 Nebula 3: dollarphotoclub.com/54924688

 Planet & nebula: dollarphotoclub.com/26339869

 Light rays: dollarphotoclub.com/54541684

 Vector effects: dollarphotoclub.com/64627579

 Skin texture: dollarphotoclub.com/3013740

 Skin pearl: dollarphotoclub.com/62060254

 Gold texture: dollarphotoclub.com/65539206

 Smoke photo: Used from my personal collection

Note: All images are copyright of the respective artist.
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EYE  LEVEL texture

texture

As you select supporting elements, you may have to 

adjust the composition accordingly. Although this 

particular composite has a basic composition, this 

concept is critical; keep the point of view and lighting of 

the stock photos in mind. Establish a line to mark your 

eye level and make sure elements that fall above and 

below this line look like they are at the correct viewpoint.
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Cleanly isolating elements is a fundamental, but critical, 

step when creating a composite. In this section, I walk 

through the process of creating a selection of the female 

subject in order to remove the background.

Step 1: Lighten edges

I start by opening the female stock photo (42076644). The 

photo is a little dark, so I add a Levels Adjustment Layer. 

Click the Create New Fill or Adjustment Layer icon in the 

Layers Panel and select Levels. Lighten the midtones.

Pen Tool selections
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Precise Standard

Direction
Point

Anchor
Point

Step 2: Starting the path

With the Pen Tool (P) selected, I begin by carefully 

selecting around the contour of the subject. My starting 

point is at the bottom, just outside the canvas. Press Caps 

Lock to use a precise cursor.

As I select, I am zoomed in 200-400%. As I make the path, 

I press the Spacebar in order to move around the canvas. 

Note: Spacebar is a quick shortcut for the Hand Tool (H).

When I want to create a curve, I click, hold, and drag

the Direction Point in order to position the curve and 

establish the direction it will take on the next click. When 

I need to adjust the established curve, I hold the (Opt/Alt) 

key while moving the Direction Point.
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Original
Anchor Point

When I need to remove a Direction Point, I press the 

(Opt/Alt) key while clicking the current Anchor Point. 

I make as few points as possible, and I’m always looking 

ahead to see how the next point will be positioned. If I 

am unhappy with a point, I press (Cmd/Ctrl)+Z. If I need 

to undo multiple times, I press (Cmd/Ctrl)+(Opt/Alt)+Z as 

many times as needed. You can increase History States in 

Preferences: (Cmd/Ctrl)+K>Performance.

Step 3: Closing the path

I continue the above steps until I complete the path. 

Once around the subject, I close the path by clicking the 

original Anchor Point. The cursor will show a circle when 

you hover over the original Anchor Point.
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Step 4: Selecting negative space

After the contour of the subject is complete, it is time to 

select the knockout areas of the photo, or the negative 

space where the background will show through. The 

contour selection will stay active; we are just adding to it.

I select the areas of the subject where the background 

will show. Starting with the bracelet, I select the inside 

portions that will be cut out.
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Step 5: Saving the path

Once all the negative spaces are selected, the path is 

complete. The path should now be saved for future use. 

To save a path, open the Paths Panel and click the small 

arrow on the Paths Panel Menu and select Save Path. We 

can now remove the subject from the background.
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Step 6: Activate selection

Activate the selection by pressing (Cmd/Ctrl) and click on 

the newly saved Path Thumbnail.

With the selection still active, choose Refine Edge from 

the Select Menu. For this image, I used a setting of 1.5 for 

the Feather. This removes the hard edges.

13

Path
Thumbnail
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Step 7: Adding a Layer Mask

Now it’s time to remove the background from the image. 

Select the bottom layer. Click the Add Layer Mask at the 

bottom of the Layers Panel. The isolation of the subject is 

now complete. If there are any small areas that need to be 

refined, I select the Layer Mask and paint with black to 

remove or paint with white to add areas back in. I use a 

small brush for this technique. Now that the isolation is 

complete, I delete the Levels Adjustment Layer and save 

the file as a .psd.

Tip: Saving separate .psd files of all your isolated elements 

is a good idea in case you need to use them again.
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1

2

3

1. Light shining from behind the model, coming from

the background stars

2. Fill light coming from the upper left, outside of frame

3. The globe is producing light around the hand

Establish your light source(s) early; they will guide the 

way you light individual elements within your composite. 

I find it intriguing to imagine what the light may look like 

in a scene. Note: Ensure the lighting in your stock photos 

match the choices you make for a light source.

Establishing a light source
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Layer grouping and naming becomes vital to your sanity 

as you build a complex, multi-layered composite. I divide 

my composites into major groups and within each major 

group, there are nested groups. I use as many nested 

groups as needed to identify layers.

My composite had four major groups; 1. Effects, 2. Alien, 

3. Earth, and 4. Background. From top to bottom:

Organizing layers
while you work
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1. Effects - All of my composites include this group. It 

contains all of the final color adjustments, filters, and 

effects that influence the entire work.

2. Alien - This group contains the female alien subject and 

anything that influences her appearance. This is the most 

detailed group as it contains multiple nested groups.

The major Alien group has the following nested groups:

 Earth glow bottom - A glow in front of the globe.

 Smoke - Smoke that stacks over the shoulder.

 Jewels and makeup - Pearl and white dots.

 Ring - Ring enlarged with nebula added to each ball.

 Wrist - Bracelet was isolated and enhanced to

 showcase gold color and effects.

 Crown effects - Crown was isolated and enhanced to   

 showcase gold color and effects.

 Alien main - Includes multiple Clipping Masks that   

 shape the appearance of the alien.

www.jamiec.com



18

3. Earth - The globe with glow effects and light streaks.

4. Background - A background group is used in all my 

composites. This background group contains the main 

space background, several nebulae, and the upper

left planet.

Although grouping and naming layers is a basic concept 

in Photoshop, naming and structuring layers within a 

complex composite becomes critical. Name every layer

as you add it to the composite and place it in an 

appropriate group.
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When I need to locate a layer, I simply go to the major 

group and expand the nested group. If I have multiple 

layers within a nested group and I’m unable to locate a 

layer quickly, I search (or filter) by layer or effect in the 

Layers Panel. In the example below, I searched by name 

and typed ‘edge’ to locate layers by that name. 

Assigning a relevant name to layers is important and will 

save you time and frustration as you work.
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With light source(s) established and elements in place, it 

is time to start imagining what the lighting and effects 

might look like for the scene. This is the process I enjoy 

most. This step relies heavily on the vision you have in 

mind for the final composition. The elements are built up 

slowly, and I often skip around within the composition.

I walk through the steps involved in building up the 

effects and lighting that shape the female subject. Start 

with the base or ‘parent’ layer – the female subject that 

we isolated with the Pen Tool.

This section relies heavily on Clipping Masks. Clipping 

Masks are layers affecting only the base or ‘parent’ layer to 

which they are attached. The female subject is the ‘parent’ 

layer, and the Clipping Masks are attached ‘children’.

Masking, blending, and
lighting individual elements
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The adding and stacking of Clipping Masks are not always 

done in order. I started with a set of Solid Color Fill Layers 

and added several more Clipping Masks above and below, 

depending on my desired effects as I worked.

In the following section, I outline how to create Fill/ 

Adjustment and empty layer Clipping Masks using 

Photoshop CS6 and earlier.

Create a Fill/Adjustment Layer Clipping Mask:

• With your ‘parent’ layer selected, hold (Opt/Alt), then

 click and continue to hold the Create New Fill or

 Adjustment Layer icon in the Layers Panel. 

 • Select the desired Fill/Adjustment type. 

 • In the resulting dialog box, select Use Previous Layer

 to Create Clipping Mask. This will clip the new   

 Fill/Adjustment Layer to your ‘parent’ layer.

Create an empty layer Clipping Mask: 

 • With your ‘parent’ layer selected, (Opt/Alt)-click the

 Create New Layer icon in the Layers Panel. 

 • Select Use Previous Layer to Create Clipping Mask.

 This will clip the new layer to your ‘parent’ layer.
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Photoshop CC and earlier: 1. You can apply/release 

Clipping Masks by placing your cursor between the layers 

and clicking with (Opt/Alt). 2. You can select the Clipping 

Mask/layer(s) and press (Cmd/Ctrl)+(Opt/Alt)+G. 3. You 

can apply/release Clipping Masks under the Layer Menu.

Create Fill or Adjustment Layer
(Hold Opt/Alt to clip)

Layer Mask

Layer Style

Blending
Mode Opacity

Create empty layer
(Opt/Alt-click to clip)
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Step 1: Blue skin tone

 • Select the base or ‘parent’ (alien) layer.

 • Create Clipping Mask: Solid Color Fill.

 Chose a blue color to tone the skin.

 Blending Mode: Color. Opacity: 79%.

 • Next, select the Layer Mask on the

 Solid Color Fill and paint with black to

 remove blue from unwanted areas.

Female subject (from Pen Tool 

selections section). The Layer Mask was 

applied before I began adding effects. 

Painted with
black to remove
unwanted areas
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Step 2: Tone bracelet

 • With the previous Clipping Mask selected,

 Create Clipping Mask: Solid Color Fill.

 I selected a tan color to tone the bracelet.

 Blending Mode: Color. Opacity: 100%.

 • I used the Pen Tool to select the bracelet and create a

 path. I used the resulting path and selection to mask

 the color effect to only show on the bracelet.

Note: Alternately, you can hand paint the color on

the bracelet.
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Step 3: Green lips

 • With the previous Clipping Mask selected,

Create Clipping Mask: Solid Color Fill.

I selected a green color to tone the lips.

Blending Mode: Color. Opacity: 100%.

• Select the Layer Mask. With the foreground color set to

black, hold (Opt/Alt) and press (Delete/Backspace).

This will fill the Layer Mask with black and hide the

green.  With the Layer Mask selected, I paint with white

over the lips where I want to reveal the green color.

Note: I used a Solid Color Fill for this layer because I

like the ease of changing colors quickly when needed.
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Step 4: Neck highlight

 • Select the base or ‘parent’ (alien) layer.

 • Create Clipping Mask: New empty layer.

 • Set foreground color to black.

 • (Cmd/Ctrl)-click on the alien Layer Thumbnail. 

 • Press (Cmd/Ctrl)+Shift+I to inverse the selection. 

 • Press (Cmd/Ctrl)+Backspace to fill with white (hidden).

Make sure you still have your new empty layer selected.

 • Press (Cmd/Ctrl)+D to deselect the selection. 

 • Select the Move Tool (V). Nudge the white into place 

using the arrow keys.

 • Add a Layer Mask to remove unwanted areas of the   

highlight. Opacity: 52% (blur to soften edge).

Optional highlight methods: 1. Use a Layer Style

(fx icon) in the Layers Panel; add a white (Inside) Stroke. 

Next, convert to a layer: Layer Menu>Layer Style>Create 

Layer. Add Layer Mask to remove unwanted areas. Blur to 

smooth edges. 2. Alternately, hand paint the edges.

Layer
Thumbnail

alien/base
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Step 5: Darken neck

 • With the previous Clipping Mask selected,

create Clipping Mask: New empty layer.

 • Using the Color Picker, select a medium

skin tone color or sample from the neck.

 • (Cmd/Ctrl)-click the alien Layer Thumbnail.

 • From the Select Menu: Modify>Contract: 60 pixels. 

 • (Opt/Alt)+Delete/Backspace to fill the area.

Make sure you still have your new empty layer selected.

 • Create a Layer Mask to remove unwanted

shadow areas, keeping the neck area.

Blending Mode: Multiply. Opacity: 93% (blur to

soften edge).
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Step 6: Neck highlight

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer. 

 • Using white with a soft brush, paint highlights along

 the face, neck, and shoulders to build up the backlight

 appearance. Lower Brush Opacity to 20% and build up

 the desired highlight. Blending Mode: Normal.
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Step 7: Crown shadows

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using a medium gray color with a soft brush, paint

 and enhance the crown shadows. Lower Brush Opacity

 to 20% and build up the desired shadow.

 Blending Mode: Multiply. Opacity: 100%.
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Step 8: Darken corner

• With the previous Clipping Mask selected,

create Clipping Mask: New empty layer.

• Using a medium gray color with a soft brush,

paint around the bottom right corner.

Blending Mode: Multiply. Opacity: 100%.

Tip: Darkening less important areas will help focus

the viewers’ attention.
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Step 9: Hand glow

• With the previous Clipping Mask selected,

create Clipping Mask: New empty layer. 

• Using white with a soft brush, paint a glow

in the palm of the hand. 

• Create a Layer Mask to remove unwanted areas.

Blending Mode: Normal. Opacity 88%.

Note: This is the starting point to integrate the hand

and globe. I’ll add similar layers as I work.
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Step 10: Painted tears

• With the previous Clipping Mask selected,

create Clipping Mask: New empty layer. 

• Using a medium gray color with a hard brush, paint

the tears/makeup. Note: using a graphics tablet

makes painting much easier. 

• Add a subtle Bevel and Emboss Layer Style (fx icon)

to add dimension to the tears.

Blending Mode: Multiply. Opacity 64%.
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Step 11: Darken neck using layer copy

 • Select the base or ‘parent’ (alien) layer. 

 • Press (Cmd/Ctrl)+J to copy the layer.

 • Press (Cmd/Ctrl)+(Opt/Alt)+G to make a Clipping Mask. 

 • Drag the layer just below the blue Solid Color Fill layer. 

 • Set Blending Mode to Multiply. Opacity: 40%. 

 • Add a Layer Mask and fill with black to hide the layer. 

 • Using a soft brush, paint with white to reveal some

 darker shading on the neck and chest. 

Tip: Using a copy of the base/parent layer set to 

Multiply/Screen is a useful technique to Burn/Dodge 

areas of your subject. Lower the opacity until you reach 

the desired effect and mask where needed.
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Step 12: Hand glow

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer. 

 • Using white with a soft brush, paint a thin

highlight on the palm.

Note: This is similar to step 9, but the desired

effect is different. The process is to build up the effects. 
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Step 13: Remove color cast from teeth

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using a medium gray with a soft brush, paint over

 the teeth area. This is to remove the red color cast.

 Blending Mode: Color. Opacity: 61%.
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Step 14: Darken eyes

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using a medium gray with a soft brush, paint in

 the eye socket area to darken around the eyes.

 Blending Mode: Multiply. Opacity: 50%.
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Step 15: Green eye shadow

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using green and then blue, paint with a soft brush

 around the eye to enhance the color of the eye

 shadow. Blending Mode: Color. Opacity: 100%.
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Step 16: Globe reflected light

 • We’ll now start working above the three

 Solid Color Fill Layers.

 • With the green fill or ‘Lips’ layer selected,

 create Clipping Mask: New empty layer. 

 • Using a yellow-orange color with a soft brush,

 paint (reflected) color onto the shoulder and palm.

 This light is coming from the globe.

 Blending Mode: Color. Opacity: 35%.

New
Position
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Step 17: Lip highlights

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer. 

 • Using white, paint with a hard brush to enhance

 the highlights on the lips. Lower Brush Opacity   

 to 20% and build up the desired highlight.

 Blending Mode: Normal. Opacity: 100%.
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Step 18: Crown highlights

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Set foreground color to black.

 • (Cmd/Ctrl)-click the ‘parent’ (alien) Layer Thumbnail. 

 • Press (Cmd/Ctrl)+Shift+I to inverse the selection. 

 • Press (Cmd/Ctrl)+Backspace to fill with white (hidden).

Make sure you still have your new empty layer selected.

 • Press (Cmd/Ctrl)+D to deselect the selection. 

 • Select the Move Tool (V). Nudge the white    

into place using the arrow keys.

 • Add a Layer Mask to remove unwanted areas.

 • Blur the highlight. In the Filter Menu>Blur>

 Gaussian Blur: 3.6 Pixels.
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Step 19: Neck highlight 

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using white, paint with a small brush along the

 neckline to create a highlight, which will add

 some separation for the neck. Lower Opacity for

 desired effect.

Note: You can also make a selection of the area you want 

to highlight and fill it with white. You would then blur and 

mask unwanted areas.
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Step 20: Back neck highlight

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using white, paint with a soft brush and add a

 highlight along the rear portion of the neck.

 Opacity: 87%.
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Step 21: Skin texture (before and after)

 • Drag the texture photo (3013740) into the composition

 and make a Clipping Mask (Cmd/Ctrl)+(Opt/Alt)+G. 

 • Position and scale. Rasterize layer (if Smart Object).

 • Desaturate the image (Cmd/Ctrl)+U and pull the

 Saturation slider to -100. 

 • Using a Layer Mask, remove unwanted areas by

painting with black.

 Blending Mode: Soft Light. Opacity: 27%.

Note: I repeated step 21 for both shoulders. I wanted to 

use the same texture, but vary the pattern where the 

shoulders meet the chest. 
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Step 22: Gold texture on clothing

 • Drag the gold texture photo (65539206)

 into the composition and add as a

 Clipping Mask (Cmd/Ctrl)+(Opt/Alt)+G. 

 • Position and scale over the clothing. 

 • Using a Layer Mask, remove unwanted

 areas by painting with black.

 Blending Mode: Soft Light. Opacity: 94%.
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Step 23: Crown color

 • With the previous Clipping Mask selected,

 create Clipping Mask: Solid Color Fill.

 An orange-gold color was used.

 Blending Mode: Color. Opacity: 100%.

 • Fill the Layer Mask with black to hide the solid fill

 and paint with white to reveal desired areas.

Note: The combination of a graphics tablet and the 

Rotate View Tool (R) in Photoshop make the painting 

motion much more natural and fluid.
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Step 24: Crown edge highlight

 • With the previous Clipping Mask selected,

 create Clipping Mask: New empty layer.

 • Using a soft brush, paint with yellow-gold

 and add highlights to the crown.

 Blending Mode: Overlay. Opacity: 100%.

Note: I repeated step 24 to paint additional highlights, 

except I used a Normal Blending Mode with 50% Opacity.
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Remaining effects

The remaining effects that apply to the female alien are 

not Clipping Masks applied to the base/parent layer. 

They are a series of nested group layers that include 

similar effects, which are masked or applied in spots over 

the alien. The stacking order was covered in the 

Organizing Layers section on page 16. Summarized are 

each group, and I explain the techniques used.

Step 25: Crown effects (nested group)

Using the same process in the Pen Tool selections   

section on page 8, I isolated the crown (independent of 

the alien). I needed to easily add effects to the crown 

without having to hand paint multiple effects. The 

following effects are all masked by the crown.
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Step 25 continued:

 • Hand painted small hairs that eased the

 transition from subject to background.

 • Solid Color Fill Layer to enhance the gold color and

 contrast. Blending Mode: Overlay. Opacity: 69%. 

 • Solid Color Fill Layer to bring out the gold tones.

 Blending Mode: Soft Light.

 • Hand painted shadows for the back edge of the crown.

 Blending Mode: Multiply.

 • Added Solid Color Fill Layer to add some blue into

 the right side of the crown (shadow area).

 Blending Mode: Soft Light.

 • Using white and a soft brush, added some glints  

 of light or highlights to the crown. Opacity: 80%.

www.jamiec.com



49

Step 26: Wrist (nested group)

Using the same process from the Pen Tool selections 

section on page 8, I isolated the wrist bracelet 

(independent of the alien). The following effects are 

masked by the bracelet.

 • Solid Color Fill Layer to add some gold color and

 contrast. Blending Mode: Overlay. Opacity: 81%.

 • Solid Color Fill Layer to enhance the gold

 color. Blending Mode: Soft Light. Opacity: 49%.

 • Levels Adjustment Layer added to brighten the

 bracelet. Pushed the highlight slider to the left.

 • Hand painted glints or highlights using a white brush.
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Step 27: Ring (nested group)

 •  Isolated the ring and increased the size.

 • Added the nebula stock photo (61830159) over each

 of the balls of the ring using a Screen Blending Mode   

 to integrate, then added a Layer Mask to hide edges.

 The green nebulae were colored using a green

 Solid Color Fill Layer with a Clipping Mask.
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Step 28: Jewels and makeup (nested group)

 • Using a small white brush, I painted dots around the

 eyes. Blending Mode: Normal. Opacity: 49%.

 • Using a small gray brush, I painted darker dots

between the eyes.

 Blending Mode: Multiply. Opacity: 51%.

 • Using the female (skin pearl) stock photo (62060254),

 I added a single pearl decoration to the center of the

 alien’s forehead.
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Step 29: Smoke over shoulder (nested group)

Using my photo of a cloud of smoke, I added a small 

amount of smoke over the right side shoulder, then 

masked unwanted areas. Blending Mode: Screen.
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Step 30: Glow over palm (nested group)

Using a stock image of light effects (64627579),

I added light rays or glow effects to the base of the globe 

and over the palm, then masked unwanted areas.

Blending Mode: Screen. Opacity: 58%.

www.jamiec.com
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Adding finishing effects helps unify the overall 

appearance. The effects vary, but generally include color 

adjustments, filters, and sometimes overpainting. In the 

following pages, I outline the steps I used for my 

composite. The final effects are in a top level group 

named Effects.

Smoke (finishing effects)

My smoke photo was inserted to add some atmosphere. 

A Layer Mask was added to remove unwanted areas. 

Blending Mode: Soft Light.

Finishing effects

www.jamiec.com
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Darken edges (finishing effects)

A gray Solid Color Fill Layer was added to burn the 

edges. Using a Layer Mask, I removed the center portion, 

leaving the edges. Blending Mode: Multiply.

www.jamiec.com
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Selective Color (finishing effects)

I added a Selective Color Adjustment Layer. I wanted

to blend and enhance the purple and blue tones. The 

Neutrals color option was chosen with the following 

settings: Cyan +20, Magenta -4, Yellow -20, Black +1.

www.jamiec.com
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Surface Blur & Reduce Noise (finishing effects)

I created a new layer and ‘merged all visible layers’ into it. 

Create a new layer at the top level and press 

(Cmd/Ctrl)+(Opt/Alt)+Shift+E. This merges all the visible 

layers into a copy. Make two copies of the merged layer 

by pressing (Cmd/Ctrl)+J. Name the lower copy Surface 

Blur and name the top copy Reduce Noise. 

Surface Blur

Using the Layer Visibility (eye icon), turn off the

Reduce Noise layer for now. Select the Surface Blur layer. 

Under the Filter Menu>Blur>Surface Blur:

Radius 3, Threshold 15.

Lower copy, Surface Blur
Top copy, Reduce Noise Mask

Before After

www.jamiec.com
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Reduce Noise (finishing effects)

 • Turn the visibility (eye icon) for the Reduce Noise layer

on and select the layer.

 • Under the Filter Menu>Noise>Reduce Noise:

 Strength 10, Preserve Details 27% (Other settings: 0).

Note: The Reduce Noise Filter is a little harsh on some of 

the details. I used a Layer Mask to remove some of the 

detail of the upper left planet and the nebula on the ring. 

This mask will reveal the Surface Blur effect from the 

lower layer, which was less destructive to those areas.

www.jamiec.com
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I hope the techniques shared will advance your 

work. Although the ebook contains a lot of technical 

information and techniques, remember that your 

creativity and story telling ability will make your work 

unique. Keep working, and enjoy your art.

I leave you with a breakdown of the basic stages of the 

photo composite, followed by a link to a time-lapse video 

showing my editing process.

Final tip: Don’t forget to save your work. I generally save 

my work in stages. For instance, Mother Earth 1.0.psd, 

1.1.psd, 1.2.psd, and so on. Save a new version whenever 

major progress occurs.

Final thoughts

www.jamiec.com
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Base background image,
transformed and positioned

Background buildup and start
of toning the female subject

Enhanced lighting and effects on
the crown and bracelet

Ring enlarged; nebulae added Finishing effects applied

Painted effects and edge
highlights added

Globe effects added to indicate
war and destruction

Female subject added after
Pen Tool isolation

Globe placed in hand

Photo composite basic stages



Mother Earth
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CONTACT

SUBSCRIBE

VIDEO

Don’t miss my latest work and news.

Submit your feedback or questions.

Watch the photo composite process in this
time-lapse video.

http://youtu.be/6Cxwv61M-Qc
http://jamiecarrollllc.com/subscribe/
http://jamiecarrollllc.com/?p=1959



